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1 INNGANGUR

Reiknad hefur verid nytt afrennsliskort af fslandi fyrir 4ratugina 1961-1990 og metin
breyting 4 afrennsli fra dratugunum 1961-1990 til 4ratuganna 2071-2100 samkvaemt
svidsmynd af loftslagsbreytingum. Notad er WaSIM vatnafarslikanid (Jasper et al., 2002;
Jasper & Kaufmann, 2003) og vedurgdgn fra Reiknistofu { vedurfreedi, reiknud med MM5
vedurlikani (Grell o.fl., 1994). Gerd hefur verid grein fyrir nidurstédum bessa verkefnis a
Orkupingi 2006 (Jéna Finndis J6nsdéttir, 2006) og i grein fyrir Hydrological Sciences
Journal (J6na Finndis Jénsdéttir, 2007). NidustdSunum i pessum tveimur greinum ber ekki
alveg saman vegna bess ad 6samremi fannst { MM5 vedurgégnunum sem notud voru og
var likanid stillt aftur og allt endurreiknad. Nidurstodurnar i sidartdldu greininni eru skv.
endurreiknudu likani og skal pvi visad { ba grein pegar vitnad er i pessa vinnu.

Skyrslur og fyrirlestrar sem tengjast afrennsliskortinu mé finna & skrdarsafninu
/vm/vvo/wasim/Skyrslur ofl en bessi greinargerd inniheldur leidbeiningar um hvernig
keyra ma WASIM likanid, baedi fyrir einstaka vatnsheedarmela og landid 1 heild. Einnig er
{ lok greinargerdarinnar titskyrt hvada skrar syna nidurstodur afrennsliskortsins og tengdra
vatnafarspétta. Frekari leidbeiningar um WASIM likansins m4 finna { leidbeiningum um
pad (WaSiM-ETH Model Description; Schulla og Jasper, 2006). Auk bpess ma finna
upplysingar um petta verkefni { skyrslu eftir Jénu Finndisi Jénsdéttur og Jon Sigurd
Pérarinsson (2004) par sem borin vour saman likankeyrslur med meldum vedurgdgnum
og reiknudum; og greinargerdum eftir Jonu Finndisi Jénsdéttir (2004) og Jénu Finndisi
Jonsdéttur og Berg Einarsson (2006) sem eru afangaskyrslur fyrir betta nyja mat &
afrennsli landsins.

2 VINNA A SNJOLFI

Ef vinna 4 med likani® 4 Snjolfi pa barf ad bia til heimasveedi fyrir vidkomandi notanda
par. Til pess parf ad hafa samband vid Olaf Régnvaldsson (or@os.is).

Ef pad hefur verid gert er hegt ad nota X-glugga til ad komast inn & Snjolf og pa eru
skilgreiningarnar eins og sjast 4 mynd 1.

A Snjélfi eru 60 nédur, hver med tveimur Grgjorvum. Ef verid er ad keyra pung likon ba
ma keyra tvo likon 4 hverri n6du en samrad skal haft vid Olaf Régnvaldsson um 4 hvada
n6dum megi keyra hverju sinni, svo ad énnur verk sem eru i gangi 4 Snjélfi truflist ekki.
Til ad tengjast n63u pa er notud skipunin ssh node31 (fyrir n6du 31). Ef keyrt er a
mérgum nédum og ef keyrslan tekur langan tima ba er gott ad geta slokkt 4 X-glugganum
4n pess ad keyrslan stoppi. Pad ma gera med pvi ad nota fortitid screen til ad opna nyjan
glugga, likanid sett af stad, annar gluggi opnadur med Ctri-a-c, og ferdast 4 milli
glugganna med Ctrl-a-n eda Cirl-a-p. Gluggunum mé svo loka med Ctrl-a-d og tengjast
aftur med screen —r. Frekari upplysingar um betta forrit mé finna 4 vefsidunum
http:/fwww.linuxmanpages.com/manl/screen.1.php og
http://www.gnu.org/software/screen/.

Nokkrir ritlar eru 4 Snj6lfi og né6dunum, t.d. vi, jed og emacs.
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Mynd 1. Skilgreiningar fyrir X-glugga a Snjolf.

2.1 Afrita gogn yfir 4 Snjolf

Gott er ad afrita strax forrit og styriskrar frd OS tolvum Jvm/vvo/wasim/snjolfur_bin og

Jvm/vvo/wasim/snjolfur_bin yfir &
og /home/xxx/forrit.

Afrita ma gdgn pangad yfir med

heimasvadi vidkomandi & Snjélfi, p.e. i home/xxx/bin

skipuninni scp (secure copy). Til demis a eftirfarandi

hatt: scp stroklur:/vm/vvo/wasim/snjolfur_bin/* bin/. En athugid ad béa parf skraarsafnid
bin ad vera til 4 vidkomandi heimasveedi 4 Snjolfi.

Onnur 1eid sem gott er ad nota til

ad flytja 4 mill er forritid WinSCP3 en bad er okeypis

forrit sem haegt er ad hlada nidur af netinu.

3 KEYRA WASIM LIKANID

3.1 Keyra likon sem sett hafa verido upp fyrir vatnshsedarmela

Likoén fyrir vatnshedarmalana eru geymd & Jvm/wvo/wasim/vhm_likon/vhmxxx (XXX
stendur fyrir vatnsheedarmaelisniimer):
- Inntaksgdgn likansins (nema vedurgdgnin) geymd a /input2 safninu



- Vedurgdgnin eru geymd & /vm/vvo/wasim/skvetta/export/klasixx (landinu er skipt upp i
fjéra hluta til ad minnka skrarnar og hér stendur xx fyrir vidkomandi landsfjérdun, nv,
na, sa eda sv).

- | /final2 skraarsafninu er keyrsluskra likansins keyrsla2.txt 4samt nidurstédum sidustu
keyrslu. Par geymir t.d skrain ggkonxxx.dat rennsli { m’/s.

- Skrain spende.dat inniheldur melt rennsli { mm/dag.

- Skyringar 4 skraarheitum méa finna i keyrsla2.txt skrénni og WaSiM  bokinni
fm/lvvorwasim/Skyrslur_ofl/wasim_2006_en.pdf.

Ef keyra parf likanid upp & nytt parf ad afrita petta fvm/vvo/wasim/vhm_likon/vhmxxx
skrdarsafn yfir 4 Snjolf. Einnig barf ad afrita fvm/ivvo/wasim/skvetta/export/klasixx
skraarsafnid yfir 4 Snjolf. Gott er ad geyma peer skrar midlegt frekar en vid hvert likan af
vatnshedarmeli, pvi paer eru stérar, pvi ma tengja /vhmoxxx/input2 skréarsafnid vid
grunnsafnid 4 eftirfarandi hatt. In -s /home/xxx/skvetta/export/klasixx/hiti.ixt ... geislun.txt
(hér stendur xxx fyrir notendanafn en xx fyrir landsfjérdung).

Til pess ad tengja allar vedurgagnaskrarnar { einu vid tiltekid /input2 skraarsafn ma nota
skrarnar Avm/Avo/snjolfur_bin/cpnv.sh ... cpsa.sh sem vista skal 4 heimasvadi
/home/xxx/bin og keyra fra /input2 skraarsafninu med skipuninni s cpnv.sh

P4 ma opna keyrsluskra WaSiM Jikansins, keyrsla2.txt sem er { /final2 skraarsafninu. bar
er heegt ad breyta ymsu, t.d. keyrslutima og ymsum studlum ef veri er ad kvarda likanid.
Peir studlar sem voru notadir til ad kvarda likonin Iysa Grkomu, snjosdfnun og bradnun,
jokulbradnun og svorun jardvegs vid tirkomu og snjobrad. Urkomuleidrétting var notud til
ad lata vatnsj6fnud passa sem best. bar sem tirkoma virdist nokkud rétt i MMS5 g6gnunum,
pé4 samsvarar bessi urkomuleidrétting yfirleitt bvi ad verid sé ad bata inn 1 vatnsjofnudinn
shrifum grunnvatns. b.e. ef mikid grunnvatn kemur fram & vatnasvidinu pa parf ad auka
,arkomuna®, pvi grunnvatnslikan er ekki notad hér. '

Fyrir snjéséfnun voru eftirtaldir studlar stilltir af:
- Hitamdork arkomu/snjokomu /s

- Hitamérk snjobradnunar T,
Gradudagastudull an vindahrifa ¢,

- Gradudagastudull med vindahrifum c;.

Joklalikaninu lysa eftirtaldir studlar:

- Bradnunarstudull MF (eins fyrir snjé, hjarn og is)

- Sérstakur studull fyrir snjé og hjarn, Olgnow, €n annar fyrir is ous.
- Geymslustudlar fyrir is, snjé og hjarn, ks, ksnow 08 Kice-

Fyrir jardvegslikanid voru eftirtaldir studlar adlagadir:
- Geymslustudull fyrir beint afrennsli kg,

- Geymslustudull fyrir rennsli 1 jardvegi ;,

- Lengd vatnsfalls / flatarmali vatnasvids d,

- Hjodnunarstudull fyrir grunnrennsli &

- Lekt efsta grunnvatnsgeymis

- Hlutfall yfirbordsafrennslis 1 snjébradnun

Likanid er svo keyrt med skipuninni s/ ../wasimpest.bat



3.2 Setja upp nytt likan fyrir vatnasvio

Ef setja 4 upp likan fyrir nyjan vatnshaedarmeli parf ad gera eftirfarandi { ArcView.

r

Alkvarda svadid sem vatnasvioid tekur til  GIS, t.d. ArcView.

Finna hvort svedid fellur &4 NV, NA, SA eda SV flokkinn, skv. gis-skranum
Svm/vvo/wasim/flokkar/flokkar xx.

Virkja Extension ,,Spatial Analyst®.

N4 { grid fyrir pann flokk, sem er einnig a fvm/vvo/wasim/flokkar/xx.

Bua til grid Gr vatnasvidinu, sem hefur gildid einn innan vatnasvidsins en ,,No
Data® utan pess, sterd gridsins 4 ad vera st sama og grid flokksins (t.d. nv). Petta
er gert med pvi velja vatnasvidspekjuna, setja parf einn délk i henni jafnt og 1,
athugid ad ef vatnasvidid er pakid jokli ad hluta pa parf ad skipta pvi upp i tvo
hluta og gefa jokulpakta hlutanum nimerid 2. Eins parf ad adgreina vatnasvid
(med mismunandi tolum) ef keyra 4 likanid fyrir tvo adskilin vatnaskil og fa
nidurstodur fyrir hvort um sig.

Velja ,theme->convert to grid®, { valmynd skal velja ,,Output grid Extent same as
Nv*, ,,Output Grid Cell Size same as Nv*, Pick field for cell values->dalkurinn
med télunni 1 og vista skréna.

Velja ,,File->Export data source-> Ascii Raster”, velja vatnasvidsgridid og skyra
nyja ascii skrd vhimxxx.ezf.

Opna skrana 4 Notepad og breyta haus hennar pannig ad 1 stad corner standi center
og haekka tdlurnar i pridju og fjérou linu um 500.

Pvi nast parf ad gera eftirfarandi 4 Snjolfi:

Bua til skraarsafn, t.d. med nafni vatnshaedarmelisins, vimxxx

Innan vhmxxx er buain til imput skréarsafn bangad sem gogn af
Jom/wolwasim/ldasar1960/xx1960/input  eru  afritud, auk nyju skraarinnar
vhmxxx.ezf. ~
Innan vhmxxx er btid til annad skraarsafn sem heitir t.d. keyrsla og pangad er
afritud styriskra keyrsla2.txt fra 6dru vhm likani' 4samt wasimpest.bat skra fra
sama vhm likani.

Skranum wasimpest.bat og keyrsla2.txt barf badum ad breyta og adlaga ad nyja
likaninu, sérstaklega parf ad muna eftir bvi ad breyta tilvisunum i $inpath = input
skréarsafnid, $zone grid = vhmxxx.ezf, $set $subcatchments = vhmxxx.ezf.

Auk pessa barf ad breyta i keyrsla2.txt skranni, coordinates of control plot, all
theta and qu-values are written to files, 1 mimer reits innan vatnasvidsgridsins sem
hefur eitthvad annad en ,,no data® gildi. Nimer reitanna eru talin frd4 nordvestur
horni gridsins, (fyrst y-hnitid, svo x-hnitid) med meelistikunni { ArcView, og deilt 1
vegalengdina med 1000).

Svo mé& keyra likanid inni 1 /keyrsla skraarsafninu med skipuninni:
sh ../wasimpest.bat.

' Athugid ad einnig er haegt ad nota styriskrar fra likaninu fyrir allt landid. Gis skrarnar
Jum/vvolwasim/flokkar/flokkar_xx syna titbreidslu hvers flokks og 1 attribute t6flu skranna
mé finna dalkinn fest sem inniheldur nafn hvers flika. Keyrsluskra fyrir hvern fladka ma
sidan finna 1 safninu AmAvo/wasim/klasar1960/xx1960/nr_flaka.



3.3 Timaradir skodaodar i Matlab

Skoda ma nidurstodur likansins og bera saman vid melinidurstodur med forritinu
wasimplot 1 Matlab. Svolitid vesen hefur oft verid ad fa pad til ad virka & hverri télvu, og
b4 oftast vegna bess ad mismunandi utgafur af Matlab eru notadar. Fram a0 pessu hefur
reynst vel ad nota Matlab 6.5.

[ Matlab parf ad gera eftirfarandi:
- File -> Set Path -> Add with subfolders -> skrdasafnid /vm/vvo/wasim/matlab.
- Sl4 inn skipunina wasimplot.

P4 opnast tveir gluggar fyrir forritid en eftirfarandi atridid tengjast pvi:

- Athugid ad til pess ad hegt sé ad teikna upp gogn fra vatnshedarmaeli parf ad vera
til spende.dat skrd med meeldum gdgnum (I mm/dag) i skraarsafninu sem visad er
i. Spende.dat skriin sem um redir parf ad nd yfir allt timabilid sem likanid var
keyrt fyrir pé svo maldu gognin séu einungis til fyrir stytira timabil. Par sem engin
gdgn eru til er fyllt upp 1 med -999 fyrir rennslid. _

- A stjérnbordinu er gluggi sem ber heitid Nafn. f pennan glugga er haegt ad skrifa
vidbatur vid endingu tttaksskréaa likansins, oftast er sjalfgefna heitid /2 rétt.

- Sem stendur er sjalfgefin gagnasléd c:/wasim/. bad parf ad muna ad beeta aftan vid
gagnasl6dina nimeri vatnshadarmelis og uttakssmdppu, t.d. vhm200/keyrsla.

- Pad eru 17 valmodguleikar sem hagt er ad velja um til ad teikna & graf. Mynd 1
kemur nedst 1 teiknigluggann og mynd 3 efst. Heegt er ad stjorna skala y-assins a
mynd 1 med pvi ad skrifa gildi { reitinn ylimit. Ef reiturinn geymir 0 skalar forritid
sjalft.

- Ef notast er vid valmyndina 4 stjérnbordinu til ad breyta myndum 1-3 er
naudsynlegt ad stydja aftur & Hlada inn gogn hnappinn 4dur en gdgnin eru teiknud.

- Hnappurinn Reikna medaltal reiknar medaltdl, R2 og R2log studlana fyrir pad
timabil sem valid hefur verid. Nidurstodurnar birtast i Matlab glugganum.

3.4 Keyra likan fyrir allt landid

Studlar fyrir WASIM likanid voru stilltic af fyrir um 70 vatnasvid (J6na Finndis
J6nsdéttir, 2007) en sidan voru beir fluttir yfir 4 klasa sem samreemast nylegri
vatnasvadaflokkun (Freysteinn Sigurdsson o.fl., 2006) par sem leitast var vid ad flokka
landsveedi eftir pvi hvernig pau bregdast vid trkomui og skila henni. Klasarnir sem likanid
var pvi sett upp fyrir eru 85 talsins og méd finna utlinur beirra i GIS skranum
fom/ivorwasim/flokkar/flokkar nv .. sv skrénum. Par er dalkurinn fest  attribute toflunum
med nafni hvers flokks. Keyrsluskrar hvers likans ma finna i /AmAvo/wasim/klasarl1960
og /vm/vo/wasim/klasar2070 fyrir framtidarsvidsmyndina.

Ef keyra 4 allt likanid aftur barf ad keyra pad fyrir hvern einasta klasa. bar sem peir eru 85
talsins, er ekki heegt ad setja 611 likonin af stad { einu en heaegt er ad keyra pénokkur likén i
einu ef mismunandi né8ur 4 Snjolfi eru notadar. P4 parf einnig ad afrita inntaksgdgn yfir a
/scratch svaedi nédanna pvi Snjolfur getur farid 4 hlidina vid pad ad lesa svo stérar skrar af
heimasvadi notenda 4 Snjélfi. Petta parf ad gera 4 eftirfarandi hatt:

- Afrita skraarsdfnin AmAvo/wasim/klasar1960 og/eda klasar2070 yfir & Snjolf.

- Fara inn 4 n6du par sem keyra 4 likanid ssh node32.

- Fara inn { rétt skraarsafn, t.d. klasar1960/nv1960/3_1




Bua til skraarsafn & /scratch svadi nédunnar: mkdir /scratch/nvinput.

Nota skréna AmAvoiwasim/snjolfur_bin/cpnv3.sh ... cpsv3.sh til ad afrita
inntaksgdgn yfir 4 /scratch sveedid 4 n6dunum. Ef hin er geymd 4 bin sveedi pa mé
keyra hana med sk cpnv3.sh. En athugid ad e.t.v. parf ad breyta tilvisunum i henni
4dur en hiin er notud { fyrsta skipti.

Ef keyra 4 Ut afrennsli og mesta snjé hvers manadar fyrir 30 ara timabil, 1961—
1990 4samt fullt af medaltolum fyrir allt timabilid mi nota skrana
vm/wolwasim/snjolfur_bin/months.sh med pvi ad skrifa 1 skréarsafni klasans (t.d.
nv1960/3 1) sh months.sh. Breyta parf tilvisunum { heimasvaedi notenda a4dur en
hiin er notud 1 fyrsta sinn.

Ef skrifa 4 Gt eitthvad annad mé audvitad adlaga skréna months.sh og per skrar
sem hun visa { eftir pvi sem purfa pykir.

Pegar buid er ad keyra likanid fyrir alla klasa ma breyta grid skram likansins 1 ascii
grid skrar (sem gis forritin skilja) med forritinu gridascii. T.d. mé nota skrarnar
gridasci_nv4.sh .. gridasci_sv4.sh til ad breyta morgum skram { einu, en eins og
4dur parf e.t.v. ad breyta tilvisunum { baer vid fyrstu notkun svo ad peer virki.

Ef leggja 4 saman rennsli af 6llu landinu eda af 6llum joklum ma nota skrana
sum1960 2.sh eda sum2070_2.sh. P4 verda til textaskrarnar alls1960 2.txt og
glc1960 2.txt sem inni halda rennsli (m’/s) af hverjum klasa fyrir sig. Pessar
timaradir ma svo leggja saman i toflureikni.

Ef bta 4 til GIS pekjur af likannidurstsdum og sameina pessa 85 buta i heildstedum
pekjum af 61lu landinu, parf ad gera eftifarandi:

Afrita skrar af Snjolfi yfir 4 OS tolvur, annad hvort med WinSCP eda scp
skipuninni.

Opna ArcInfo og fara 4 stadinn par sem skrarnar eru geymdar. (ArcInfo mé opna {
Unix glugga, t.d. Strokk, med pvi ad skrifa farc).

Keyra skrarnar /vm/vvo/wasim/keyrsla1960/seasons_run_nv.txt ...
seasons_run_sv.txt til ad sameina méanada skrér innan hvers klasa. Skrérnar eru
keyrdar innan ArcInfo med pvi ad skrifa: grid og svo &run seasons_run_sv.1xt.
Keyra skrarnar Am/vvo/wasim/keyrslal960/run_nvI.ixt ... run_svl.txt til ad
sameina medaltals skrér fyrir hvern klasa (grid, &run run_svI.txt { ArcInfo).

Keyra skrdna /vm/vvo/wasim/keyrslal960/merge.ixt til ad sameina medaltalsskrar
fyrir allt landid (grid, &run merge.txt 1 ArcInfo).

Keyra skréna /vm/vvo/wasim/timaradirl 960/seasons_timarod.txt til ad sameina
méanadarskrarnar fyrir allt landid (grid, & seasons_timarod.txt 1 Arclnfo).

¥

Athugid ad pad getur verid seinlegt ad sameina allar pessar GIS skrar, forritid stoppar
kannski pénokkrum sinnum. bvi tekur pessi pattur mun lengri tima en e.t.v. virdist { fyrstu.

Ef keyrd er svidsmynd fyrir framtidarvedurfar er flest gert 4 svipadan hatt en athuga ber
eftirfarandi:

Intaksskrarnar, p.e. paer sem sntia ad tlinum klasa dsamt had eru littillega breyttar
vegna annarrar Utbreidslu og hadar jokla. bvi parf ad nota input skrdarsofn fra
klasar2070 1 stad klasar1960.

Svidsmynd af breyttu vedurfari er sett inn sem deltabreyting, p.e. breyting a
medalhitastigi manada (°C) og hlutfalls (%) breytingu & medaltrkomu. betta er
gert i keyrsluskranum (keyrsla.txt) og hefur verid gert pannig ad par sem
tirkomubreytingin er mismunandi fyrir mismunandi landshluta pa hafa verid
skilgreindir hnitpunktar fyrir hvern landshluta og breytingin latin fylgja peim
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hnitpunktum. Pad er hins vegar ekki skyrt hvernig WASIM briar 4 milli
hnitpunkta sem breyting er skilgreind fyrir. Pvi veeri veentanlega betra nast pegar
keyrd er svidsmynd af veSurfari, ad skilgreina betur fyrir hvada svadi hvada
deltabreytmgar gilda. T.d. ef landinu er skipt upp { fjéra hluta, hvad vardar
breytingu 4 trkomu, eins og gert var { sidustu svidsmynd, pa veeri sennilega best ad
setja einungis breytinguna sem 4 ad vera 4 NV-landi, inn { keyrsluskrér { klasanum
sem kenndur er vid NV-land o.s.frv.

- Keyrsluskrar virka flestar fyrir bedi 1961-1990 og 2071-2100 timabilin en
einhversstadar kann ad purfa ad breyta tilvisunum, auk pess eru sumar skrar
kenndar vid timabilin, annad hvort 1960 eda 2070 og béa ber ad nota sitthvort
skrana fyrir sitthvora keyrsluna.

4 NA I MM5 VEPURGOGN AF SKVETTU

Gogn fra ,,nyJu“ keyrslunni med MMS5 likaninu er skipt upp i fjora hluta a
Jvmiwvo/wasim/skvetta/export/klasiny ... klasisv. Dbetta eru dagsgildi, par sem medaltal
hefur verid tekid af fjérum utreiknuéum gildum MMS5 likansins fyrir hita (°C), raka (hPa)
og vinds (m/s), auk uppsafnaérar urkomu (mm/dag). Athugid ad vegna misskilnings er
medaltal stuttbylgju-inngeislunar (Watt/m ) margfaldad med 24 i pessum skrdm. Pvi hefur
geislun { WaSiM likaninu veri® margfoldud med leidréttingarstudlinum 0.042.

Ef 6skad er eftir MMS5 gognum med meiri timaupplausn (fijogur gildi 4 dag), fyrir
takmarkad landsvaedi eda fyrir fleiri vedurpeetti ba parf ad né 1 vedurgdgnin 4 Skvettu a
Snjolfi. Til pess parf vidkomandi ad vera skradur 4 Snjélf og vera med ymsar tilvisanir
réttar 1 .bashre skranni sinni og réttar skrar { /bin safninu sinu 4 Snjolfi.

4.1 Undirbaningur: Afrita styriskrar og laga tilvisanir

- Skrain Am/Avvo/wasim/snjolfur_bin/.bashrc er af svadi JFJ 4 Snjélfi en adrir purfa ad
breyta tilvisun 1 hennar heimasveedi yfir 1 sitt.

- Skrarnar /vm/vvo/wasim/snjolfur_bin/idl_skvetta og
fvm/vvo/wasim/snjolfur_bin/skvettav2 dsamt skraarsafninu
fm/vvolwasim/snjolfur_bin/TOOLS _MMS5 burfa ad vera a /home/xxx/bin svedinu &
Snjolfi. Auk pess parf ad bua til skrdarsafnid /rome/xxx/skvetta_log og breyta skranni
/home/xxx/bin/skvettav2 svo ad hin visi { rétt heimasveedi.

4.2 Undirbuningur: Textaskra med hornpunktum svaedis

A Snjolfi parf ad vera til textaskrd med 6llum hornpunktum bess svedis sem draga 4 ut
MMS5 gbgn fyrir. Svona skrd ma finna & /vm/vvo/wasim/skvetta/vatnasvid/fnjoska.txt en
hana ma t.d. Gtbua 1 ArcView og ArcInfo & eftirfarandi hatt:
- Utlinur sveedis eru dregnar i ArcView/ArcMap, betta geta t.d. verid utlinur
vatnasvids sem til er 1 gagnagrunni VM og vistadar sem shapefile svaedi.shp.
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ArcInfo mé opna i Unix glugga med skipuninni farc. [ ArcInfo (workstation) mé
svo gefa eftirfarandi skipanir:

- Arc: Shapearc svaedi svaedi (bda til coverage fyrir sama svacdi)

- Arc: Build svaedi poly

- Arc: Ungenerate poly svaedi svaedi.txt (hornpunktar skrifadir ut i textaskra)

- Arc: quit

- Svo parf ad opna textaskranni og eyda fyrstu linunni tr henni. Eftir pad er hin
tilbuin til notkunar 1 Skvettu.

4.3 Keyra Skvettu

A Snjolfi eru skipanirnar eftirfarandi:

- idl

- IDL>.compile /home/ossi/idl/VMgui2/skvettav2

- IDL> Skvettav2
b4 opnast notendavidmoét Skvettu par sem velja skal skra sem inniheldur alla hornpunkta
sem skilgreina vidkomandi svaedi. Einnig skal velja hvada MM5 vedurpeetti 4 ad draga ut
og sidast skal valid hvar skal vista skrana. Pegar betta hefur verid valid byrjar forritid ad
draga ut gdgnin. Fljétlega kemur 4 Linux skjainn fyrir aftan notendavidmotid eftirfarandi
setning: Done saving input for restore, ok to abort now. P4 ma hvort sem er bida med

forritin opin par til Skvetta hefur lokid vid ad na { gognin (pad getur tekid langan tima).,

Eda loka notendavidmétinu med Ctrl-c og hetta 1 IDL. P4 mé sja ad vistast hefur i
skriarsafninu skréd sem heitir skvettav2 restart dags timi.sav og nota mi hana til ad
endurrzesa skvettu (4n notendavidmots) med pvi ad skrifa skipunina: sh skvettav2

Pegar gognin eru komin fra Skvettu mé skoda textaskrarnar med gégnunum, radlegt er ad
nota skipanirnar more, head eda tail frekar en opna heildarskrana ef gagnaskrain er 16ng.
Efst 1 hausnum eru upplysingar um hvada veSurpéttur er i bessari skra, sidan kemur
fjégurra lina haus sem er snidinn ad WaSiM likaninu: f fyrstu linu er heed yfir sjavarmali,
annarri x-hnit skv. Lambert (ISN93), pridju y-hnit skv. Lambert (ISN93) og { fjérdu linu
eru hlutfall 8x8 km MMS5 reitsins sem fellur innan pess svadis sem afmarkad var til ad
draga ut gogn fyrir 1 Skvettu.

MMS5 skrarnar eru med fjérum gildum fyrir hvern dag. Ef finna 4 dagsmedaltol ut fra
fjorum gildum fyrir hvern dag ma nota forritin regn.sh, hiti.sh, raki.sh, vindur.sh og
geislun.sh sem finna ma i /vm/vvo/wasim/snjolfur_bin skraarsafninu.

Pessi fimm forrit virka 4 eftirfarandi hatt, athugid ad sumar skrér geta verid of storar fyrir
forritin til ad hondla, b4 parf ad skipta peim upp i smeerri hluta 48ur en forritin eru keyrd.
1. Skréarnar raincon.txt og rainnon.txt sameinadar { eina skra og fjégur urkomugildi
fyrir daginn sameinud { eitt. Petta er gert med pvi ad keyra skipun: sh regn.sh i
sému moppu og skrarnar eru geymdar. Ny skra heitir regn. txt.
2. Skrénni T2m.txt breytt pannig ad tekid er medaltal af fjérum hitagildum fyrir
daginn med pvi ad keyra skipun: sh hiti.sh Ny skra heitir hiti.txt.
3. Skrarnar vI0m.txt og ulOm.txt sameinadar 1 eina skra likt og vigursamlagning, b.e.
hvor skra um sig er hafin { annad veldi, peer lagdar saman og tekin kvadratrot.
Sidan er tekid medaltal af gildunum fyrir hvern dag. Keyra skal skipun: sh
vindur.sh Ny skré heitir vindur.txt.
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4. Skrénni swdown.txt breytt pannig ad dagsgildin fjdgur eru 16g0 saman og
margfoldud med 6. Keyra skal skipun: sh geislun.sh Ny skrd heitir geislun.txt.
Athugid ad pad er { raun rangt ad gera betta, geislunargildin eru 1 Wottum/m” og
pvi atti ad taka medaltal 1 stad pess ad leggja saman. Til ad f4 medalgeislun yfir
s6larhringinn parf pvi ad deila i pessi gildi med 24 klst.

Ef frekari upplysinga og leidbeininga vardandi Skvettu ma reyna ad hafa samband vi0
héfunda hennar Omélf Régnvaldsson (ornolfur.rognvaldsson@gmail.com) eda Olaf
Rognvaldsson (0r@os.is).

5 GOGN FRA AFRENNSLISKORTI FYRIR TIMABILID
1961-1990 OG SVIDPSMYND FYRIRI 2071-2100

Afrennsliskortid fyrir dratugina 1961-1990 4samt svidsmynd af vedurfari fyrir 2071-2100
eru 611 geymd inni 4 Am/vvo/wasim medaltalskort eru undir [keyrslal 960 og /keyrsla2070
néfaunum, ménadakort undir /timaradirl960 og /timaradir2070 og samanburdur &
keyrslunum undir nafninu /keyrslal960_2070.

f skraarsafninu /keyrslal960 eru eftifarandi skrar sem allar lysa medaltali 30 ara, 1961—
1990, skrar med somu skrdarheitum eru i skrdarsafninu /keyrsla2070 fyrir medaltal
svidsmyndarinnar, 2071-2100:

q alls Afrennsli (mm/dag)
q_alls_djf Afrennsli des—feb (mm/dag)
q alls_jja Afrennsli jin—4g (mm/dag)
q alls mam  Afrennsli mar-maf (mm/dag)
q_alls_son Afrennsli sep-n6v (mm/dag)
q wmonthl  Afrennsli sep (mm/dag)

q wmonth2  Afrennsli okt (mm/dag)

q wmonth3  Afrennsli n6v (mm/dag)

q wmonth4  Afrennsli des (mm/dag)

q wmonth5  Afrennsli jan (mm/dag)

q wmonth6  Afrennsli feb (mm/dag)

q wmonth7  Afrennsli mar (mm/dag)

q wmonth8  Afrennsli apr (mm/dag)

q wmonth9  Afrennsli maf (mm/dag)

q wmonth10  Afrennsli jin (mm/dag)

q wmonth11  Afrennsli jil (mm/dag)

q wmonth12  Afrennsli 4glst (mm/dag)
rain_all Rigning (mm/dag)

prec_all Urkoma (mm/dag)

snow_all Snjokoma (mm/dag)
sday_all Dagar med snjopekju (dag/ari)
$SX Mesta snjopykkt medalvetrar (mm)
etp all Gnottargufun, (mm/dag)
etr_all Uppgufun (mm/dag)
temp_all Hiti (°C)

wind all Vindur (m/s)
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I skraarsafninu /keyrslal960 2070 eru skrér til samanburdar & timabilunum tveimur, b.e.
1961-1990 og 2071-2100. Pessar skrar voru bunar til fyrir skyrsluna ,,Mapping Water
Resources in the Nordic Region Under a Changing Climate* (Beldring o.fl., 2006) og er
afrit af peim { UTM28 vorpun geymd i skraarsafninu /keyrslal1960_2070/u28. Helstu skrar

i /keeyrslal960 2070 eru eftirfarandi:

q1960_alls Afrennsli (mm/ari), 1961-1990
q1960_1 Afrennsli sep—név (mm), 1961-1990
ql1960 2 Afrennsli des—feb (mm), 1961-1990
ql960_3 Afrennsli mar—maf (mm), 1961-1990
ql960_4 Afrennsli jin—4g (mm), 1961-1990
q2070_alls Afrennsli (mm/ari), 2071-2100
q2070_1 Afrennsli sep—né6v (mm), 2071-2100
q2070_2 Afrennsli des—feb (mm), 2071-2100
q2070_3 Afrennsli mar—-maf (mm), 2071-2100
q2070_4 Afrennsli jin—4g (mm), 2071-2100

qalls_mism_mm Mismunur 4 afrennsli (mm/4ri), fré timabilinu 1961-1990 til 2071-2100

galls_mism p
ql_mism_mm

Mismunur 4 afrennsli (%), fra timabilinu 1961-1990 til 2071-2100 :
Mismunur 4 afrennsli sep-név (mm), fra timabilinu 1961-1990 til 2071-2100

ql_mism p  Mismunur 4 afrennsli sep—n6v (%), fra timabilinu 19611990 til 2071-2100
g2 mism_mm Mismunur 4 afrennsli des—feb (mm), fr4 timabilinu 19611990 til 20712100
q2 mism p  Mismunur 4 afrennsli des—feb (%), frd timabilinu 19611990 til 2071-2100
q3 mism_mm Mismunur 4 afrennsli mar-maf (mm), fr4 timabilinu 19611990 til 2071-2100
q3_mism p  Mismunur 4 afrennsli mar-maf (%), fr4 timabilinu 1961-1990 til 2071-2100
g4 mism_mm Mismunur 4 afrennsli jin—4g (mm), fr timabilinu 1961-1990 til 2071-2100
g4 mism p  Mismunur 4 afrennsli jin—4g (%), fré timabilinu 19611990 til 2071-2100
sday 1960 Dagar med snjopekju (dag/éri), 1961-1990

sday 2070 Dagar med snjopekju (dag/éri), 2071-2100

day_mism Mismunur 4 fjolda daga med snjopekju, fra timabilinu 1961-1990 til 2071-2100
etr 1960 Uppgufun (mm/ari), 1961-1990

etr 2070 Uppgufun (mm/4ri), 2071-2100

etr mism_mm
maxsno_1960
maxsno_2070

Mismunur 4 uppgufun (mm/4ri), fra timabilinu 19611990 til 2071-2100 A
Mesta snjopykkt medalvetrar (mm), 1961-1990
Mesta snjopykkt medalvetrar (mm), 2071-2100

maxsno_p Mismunur 4 mestu snjopykkt vetrar (%), fra timabilinu 1961-1990 til 2071-2100
power1960 Orka { rennandi vatni 1961-1990 (W klst/4ri/m”)
power2070 Orka { rennandi vatni 2071-2100 (W klst/4ri/m")

likan_studlar.xls Yfirlit yfir skilgreinda likanstudla fyrir mismunandi klasa

Timaradir afrennslis, badi af 61lu landinu og sérstaklega fra joklum landsins eru geymd i
gagnasafni Vatnamealinga undir eftirfarandi nimerum:

20001 Island, reiknad afrennsli 1961-1990 margfaldad med 0,1

20002 fsland, reiknad afrennsli 2071-2100 margfaldad med 0,1

20003 Island, reiknad afrennsli 1987-2001 margfaldad med 0,1 (eldri kvérdun)
20004 Joklar 4 {slandi, reiknad afrennsli 1961-1990 margfaldad med 0,1
20005 Joklar 4 fslandi, reiknad afrennsli 2071-2100 margfaldad med 0,1

Med “Joklum 4 fslandi” er 4att vid pa reiti sem merktir eru sem joklar i pekjunni
/vm/vvo/wasim/inntaks _grid/ice firn.
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